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 To Find Information In This Help
You can use the Epson Stylus Series Help Window just like the Help windows you find in other 
applications. If you are not familiar with how Help operates, here are a few quick procedures to get you 
started.

 Using the Help Buttons
There are seven buttons near the top of this Help Window. You can "press" a button by clicking on it with 
your mouse.

To return to and view the main contents:

Press 

To search for information about a particular topic:

1. Press .    The following window appears on your monitor:

2. Type or select a key word and then press 

3. Select a topic from the list and then press    

To go back to the screen that you viewed previously:

Press 

To jump back to a topic that you have previously viewed:



1. Press 

2. Select the topic that you want to review from the history list.

To display a Glossary of terms:

1. Press .    The following Glossary Window appears:

2. Use the , 

, 

, or 

 buttons to jump to the area you want to check.
3. Select the term that you want to see a definition for.
4. Close the Window when you are finished.

To move on to the next topic in the browse sequence:

Press 

To go back to the previous topic in the browse sequence:

Press 

 See Also
For More Information About Using Help in Windows



For Help About a Dialog Box or Message
Hypertext and Hypergraphics provide a quick way to get more information about a dialog box or message 
on the screen. They also provide a quick way to jump to other related topics.

Important!      When you pass over hypertext or hypergraphics, you cursor changes from an arrow to a 
pointing finger.

Hypertext displays on your screen as green text, as shown below:

The printer driver includes on-screen examples.

When you select hypertext with a dotted underline, Help displays a pop-up box that contains more 
information about the term. To close the pop-up box, click a mouse button or press the Esc key.

When you select hypertext with a single underline, Help jumps directly to the underlined topic.

Hypergraphics are usually buttons that you press to perform a function or areas of a picture that you can 
select to display more information about the image.

 See Also
For More Information About Using Help in Windows



For More Information About Using Help in Windows
To learn more about how to use all of Help's features, refer to your Windows documentation or select 
Help from the Help Menu.



Browse Sequence
A browse sequence follows a path through the topics in Help in a certain order.

The browse sequence in the Epson Stylus Help Window is designed to provide a tutorial on how to use 
the most important features of your printer driver.



About the EPSON Stylus Series Printing System
Welcome to the EPSON® Stylus™ Series printing system, where printing is fast and effortless and your 
output is customized for all your printing needs.

You install the EPSON Stylus Series printing system the same way as any other Microsoft® Windows® 
printer driver, but the EPSON driver has some major advantages over the conventional Windows 
technology:

The printer driver includes on-screen examples of how your images will print as you change the printer
driver settings.

The printer driver screen is divided by simple-to-use folder tabs that follow the graphic style of 
Windows.

The software release time is much quicker than conventional printer drivers, even when you use 
sophisticated print settings, such as error diffusion.

Colors are richer and truer to the screen image due to the printer drivers automatic color adjustment 
settings for screen-to-printer WYSIWYG.

Photographs look realistic and graphics are smoother because of the drivers advanced diffusion 
halftoning and MicroWeave features.

Print time is generally significantly shorter than with other ink jet printers, even when the driver is 
processing color images or interfacing with advanced 24-bit per pixel devices.

The status monitor in the Despooler displays the current printer status, and if you are using Windows 
95, the cartridge ink levels.

In addition, you can use a wide variety of printer driver options to create fantastic printed images without 
sacrificing overall system performance.

 See Also
Technical Description



EPSON Stylus Series Printer Driver
The printer driver is usually accessed through your applications Printer Setup option or from the Printers 
icon of the Microsoft Windows Control Panel.

The printer driver allows your computer to use all of the features and capabilities of your EPSON Stylus 
Series printer.



Release Time
This is the time that it takes for control to return to you from the Print option within your application.

The EPSON Stylus Series printing system returns you to your application quickly so that you can continue
working while your printing completes in the background.



WYSIWYG
What You See Is What You Get.    Generally with the EPSON Stylus Series printing system, what you see 
on the screen is what you get on the printer in terms of colors, image size, print density etc.



Error Diffusion
Most printing systems use dithering to represent an image, which can give quite a grainy result.    The 
EPSON Stylus Series printing system supports error diffusion printing and uses an advanced rendering 
technique to generate a smoother image.    Graduated fills look better, images look clearer and 
photographs look much closer to the original.

With very complex images, error diffusion printing can sometimes take a little longer than dithering but 
generally the results are well worth it. You will have to experiment with the halftoning method that best 
suits the picture that you are printing.



Dithering
When images are printed using the dithering selections from the halftoning tab, the EPSON Stylus Series 
printing system uses a matrix of dots to represent the image.    This is in common with other Windows 
printer drivers.    You will have to experiment with the halftone method that best suits the picture you are 
printing. The error diffusion setting should give the best results in the majority of cases.



MicroWeave
When MicroWeave is selected, the EPSON Stylus Series printer driver enhances the quality of printed 
images. This is done by passing the print head over the page multiple times, laying down parts of the 
image on each pass. This technique reduces unwanted banding in images.

Images printed by other ink jet printers often have distracting horizontal bands that appear darker or 
lighter than the rest of the image. With the MicroWeave option turned on, these bands in images are 
minimized and your EPSON Stylus output looks truly professional. MicroWeave does not affect text 
output quality.

Since MicroWeave requires several passes during printing, output is slower for monochrome printing. To 
save time you should use it only for presentation quality images.

MicroWeave does not affect color printing speed significantly so you should use it for all color printing.



The EPSON Stylus Printing System -
A Technical Description
For those users who are familiar with the internal operations of Microsoft® Windows®, the following 
technical description may be of interest.

The EPSON Stylus Series printing system is an advanced Windows GDI-style software printing system 
which operates as follows:

The application is told by the printer driver that the printer is a raster device but can render the entire 
image in a single band. The driver also reports that certain advanced printing options are supported.    
All of these special capabilities save the application work and avoid the overhead of having to replay 
the picture multiple times.

The GDI commands necessary to represent the image are encoded into a highly-optimized journal file. 
The application releases when generation of the journal is complete.    In comparison with the spool 
files generated by standard Windows drivers, Journal files are very compact and are the same size 
regardless of whether the print is in color or monochrome.    Holding the information in a journal means
that the entire document can be replayed to simulate multiple hardware copies or to provide last-to-first
printing options.

The EPSON Spool Manager is responsible for initiating the EPSON Despooler which replays the 
journal file back to the mini-driver for the target device.    Both the EPSON Spool Manager and EPSON
Despooler use a highly-efficient, multi-threaded tasking system to ensure minimum impact on the 
foreground application.

Additionally, the EPSON Despooler displays the following status items when the driver is used with 
Windows 95 and the computer hardware is equipped with a bi-directional parallel port:

- Printer status (icon) Time out, During checking, IQ Received, During printing, Low ink

- Current ink quantity (bar graph): Black, color



Windows GDI
Graphics Device Interface (GDI).    This is the part of the Microsoft Windows environment that allows 
programmers to draw lines, circles, polygons, text and control other graphics elements on the output 
device (screen, printer, plotter etc.).



Journal File
The EPSON Stylus Series printing system generates a compact journal file that contains a complete 
description of your print job in a form that can be processed easily.    This journal file is similar to a tape 
recording in that it can be played, replayed, and rewound in order to process your print job.



Copyright and Trademark Information

The EPSON Stylus Series printing system is a development of Software 2000 Ltd., Oxford, England.

Portions Copyright © 1994,1995,1996 Seiko Epson Corporation

Copyright © 1994,1995,1996 Software 2000 Ltd., Oxford, England

All rights reserved.

All other trademarks of their respective owners are recognized. EPSON disclaims any and all 
rights in those marks.
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 Using the Driver Menus
When you display the printer driver system, you see the following six folder tabs at the top of the window:

The folder tabs describe the six main menus that you can access to make printer settings.

 Selecting A Folder

To select a specific folder:

Click the tab with your mouse or hold down the Alt key and press the underlined character in the tab.

 Choosing Settings
When you have selected a folder, you can select settings in any of the following ways:

Click the option button or name

Click the check box

Click the drop-down list box, then click the item

Click the text box, then enter the number.

 Saving Settings

To save the settings you have selected:



Click on 

This exits you from the driver setup and saves your selections. Your settings stay in effect until you make 
additional changes and choose the Ok button again.

 Restoring Default Settings

To restore the driver's factory default settings:

Click on 

 Exiting the Driver
There are two ways to exit the setup screen:

To exit the printer driver setup and save all the settings you made:

Click on 

To exit the printer driver setup and ignore all changes you made:

Click on 

 See Also
A Quick Guide to Using Help



Document Type Menu
To display the menu that lets you choose the type of document you are printing:

Click on       You see:

Use the Document Type menu to select the:

 Document Type  Ink Type



 Paper Menu
To display the menu that lets you choose the type of paper you are printing on:

Click on       You see:

Use the Paper menu to specify the:

 Paper Size  Paper Orientation

 Paper Source  Copies / Collation



 Printing Mode / Options Menu
To display the menu that lets you choose from various printing modes:

Click on         You see:

Use the Printing Mode/Options menu to select the:

 Printing Modes  Media Type

 Print Options



 Image Settings Menu
To display the menu where you can change the printer's image settings:

Click on         You see:

Use this menu to modify a document's color (or grayscale) settings.

If you are not familiar with color printing processes and you simply want to print high-quality color (or 
black-and-white), do not change the original settings. However, if your software does not allow you to 
make adjustments and you want to modify your images, experiment with the settings until you achieve 
satisfactory results.

Use the Image Settings menu to:

 Adjust the Image Settings

 Choose the Color Matching Type



 Halftoning Menu
To display the menu that lets you choose from various halftoning methods:

Click on         You see:

Use the Halftoning Menu for:

 Choosing a Halftoning Method



Viewing Information About the Epson
Stylus Series Driver
To display general information about your Epson Stylus Series printer driver:

Click on 

If you need technical support for a EPSON Stylus Series printing system, it is a good idea to make a note 
of the version information on this tab before you call.

 See Also
Ordering Supplies

Copyright and Trademark Information
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 Choosing a Document Type
To display the menu that lets you choose the type of document you are printing:

Click on       You see:

Use the Document Type menu to select the:

 Document Type

 Ink Type



 Document Type
The Document Types setting you select depends on what you want to print.

Automatic -- This setting lets your printer driver analyze the print data and automatically adjust the 
settings to obtain the best possible results.    For most printing jobs, leave the option set to 
Automatic.

Presentation -- This setting is best for graphics-intensive documents such as presentations. Vivid 
color matching is selected.

Photograph -- This setting is best for printing photographs. Photo-realistic color matching is selected.



Drawing -- This setting is best when printing computer-generated illustrations. Standard color 
matching is selected.

Text -- This setting is best when printing text-only documents. Photo-realistic color matching is 
selected.

When you select the document type, the Halftoning and Color Matching options are set automatically as 
shown below:

Options Halftoning Color Matching

Presentation Error Diffusion Vivid
Photograph Error Diffusion Photo-realistic
Drawing Error Diffusion Standard
Text Error Diffusion Photo-realistic

Note: If you change the halftoning or color matching settings after you have selected the document type, 
the document type setting is not available.

 See Also
Choosing the Color Matching Type



 Ink Type
This setting determines the print colors for your document.

Monochrome -- This setting selects black and white printing.

Color (CMYK) -- This setting prints in color using combinations of cyan, magenta, yellow, and black.

 See Also
Adjusting the Image

Choosing the Color Matching Type



Vivid Color Matching
Intensifies the colors and lightens the midtones and highlights of an image. Use this setting for 
presentation graphics, such as charts and graphics.



Photo-realistic Color Matching
Increases the contrast in an image. Use this setting for color photographs.



Standard Color Matching
Provides output that closely matches the original screen colors. Use this setting for illustrations.



 Choosing a Paper Type
To display the menu that lets you choose the type of paper you are printing on:

Click on       You see:

Use the Paper menu to specify the:

 Paper Size  Paper Orientation

 Paper Source  Copies / Collation



 Paper Size

Select the paper size you have loaded in the printer. The illustration under the list changes according to 
the paper size and orientation you select. Your choices are:

Type Dimensions

Letter 8-1/2 X 11 inches
Letter (Landscape) 11 X 8-1/2 inches
Letter (Centered) 8-1/2 X 11 inches
Legal 8-1/2 X 14 inches
Legal (Centered ) 8-1/2 X 14 inches
US B 11 X 17 inches
A3 297 X 420 mm
Super A3/B 329 X 483 mm
A4 210 X 297 mm
A4 (Landscape) 297 X 210 mm
A4 (Centered) 210 X 297 mm
Statement 8-1/2 X 5-1/2 inches
Executive 7.5 X 10-1/2 inches
#10 Envelope 9-1/2 X 4-1/8 inches
DL Envelope 220 X 110 mm
A6 Index card 105 X 148 mm
User defined 100 to 329 mm X 100 to 1117 mm

Note:    Select Letter (Landscape) or A4 (Landscape) when you load Letter or A4 paper with the wide 
edge first. If you select Landscape as the Orientation with Letter (Landscape) or A4 (Landscape), the 
printing result would be the same as if you selected Portrait with Letter or A4.



 Paper Orientation
To change the orientation, click the appropriate option button.

Portrait -- Prints on the page upright.

 Landscape -- Prints on the page lengthwise, which is useful for spreadsheets or presentations.



 Paper Source

Your Stylus Series printer has a built-in sheet feeder, so you do not need to change this setting.



 Copies / Collation
These settings let you specify printing of multiple copies.

 Entering the Number of Copies

To specify the number of copies:

1 Click in the text box.

2 Enter the number using your keyboard. You can enter a number from 1 to 99.

 Choosing the Collation Method
The two additional Copies options are Collate and Reverse Page Order. An X inside either of these 
check boxes indicates the option is turned on. The option is turned off when the box is empty.

To print multiple-page documents in sets:

Turn Collate on by clicking the check box.

To print one or more document sets so that each is stacked in the correct order after printing:

Click both the Collate and Reverse Page Order check boxes.

To print one multiple-page document so that its pages are in the right order after printing:

Click only Reverse Page Order.

Note:    The above options may require additional system memory. If a memory error message appears 
and you are unable to print your document, you should increase system memory, decrease the number of
open applications, reduce the size of your document, or turn off collation and/or reverse page ordering.



 Choosing the Printing Mode

To display the menu that lets you choose from various printing modes:

Click on         You see:

Use the Printing Mode/Options menu to select the:

 Printing Modes  Media Type

 Print Options



 Printing Modes
The three available printing modes are:

Super - 720 dpi

Best - 360 dpi

Draft - 180 dpi
Note: The higher the dpi setting, the longer the printing time.

 See Also
Media Type

Print Options



dpi
dots per inch. This is the number of dots your printer can print in a one inch distance in both the horizontal
and vertical dimensions. Note that if you double the dpi, you increase the total number of dots by a factor 
of four.

Note:    The Printing Modes options do not necessarily yield the same resolutions in both the vertical and 
the horizontal directions.



 Media Type

Your EPSON Stylus Series printer can print on most types of paper. However, to get the best results it is 
important to match the printing mode setting to your paper type.

Note:    Before changing the media type, change the printing mode.

The printing modes available for each media type are:

Printing mode Media type

Super - 720 dpi Plain paper
Special coated paper - 720 dpi
Special coated paper - 360 dpi
High quality glossy paper

Best - 360 dpi Plain paper
Special coated paper - 360 dpi
Transparency film

Draft - 180 dpi Plain paper

The available media types are:

Plain paper
Select this option for most types of documents. You should also select this option if your paper is not a 
special coated paper, high-quality glossy paper, or transparency.

Special coated paper - 360 dpi
To obtain good print quality, you can use special coated paper for ink jet printers. Use EPSON Special 
coated paper for 360 dpi printing and select this option. This option is also recommended for other coated
paper for ink jet printers.

Special coated paper - 720 dpi
To get the highest print quality, use EPSON Special coated paper for 720 dpi printing and select this 
option. This setting should also be used when printing on the front (coated) side of EPSON Special 
coated index card for 720 dpi printing. If you want to print on the back of an index card, select Plain 
paper as the media type.

Transparency
To print overhead transparencies, use EPSON Transparency and select this option and the Best - 360 
dpi printing mode.
Note:    Use EPSON Transparencies only. No other type of transparency is supported.

High quality glossy paper
Select this option and Super - 720 dpi printing mode and use EPSON High quality glossy paper for output
at 720 dpi.



Note:    Use only EPSON High quality glossy paper. No other type of glossy paper is supported.

 See Also
Printing Modes

Print Options

Ordering Supplies



 Print Options

Your print quality settings are:

MicroWeave

When MicroWeave is selected, your printer generates superior output because your graphics data is re-
ordered and printed in finer increments. This technology reduces the possibility of banding -- uniform lines
in graphics.
For best results, use EPSON's special coated paper, transparency, or high-quality glossy paper with 
MicroWeave.
Note:    MicroWeave is recommended for printing in color. You can select MicroWeave for Monochrome 
printing, but the printing time is significantly longer.

High speed

When you select this option, printing is performed in both directions: as the print head moves from left to 
right and right to left. Bidirectional printing is faster and is recommended for most printing.

 See Also
Printing Modes

Media Type



 Changing Image Settings
To display the menu where you can change the printer's image settings:

Click on         You see:

Use this menu to modify a document's color (or grayscale) settings.

If you are not familiar with color printing processes and you simply want to print high-quality color (or 
black-and-white), do not change the original settings. However, if your software does not allow you to 
make adjustments and you want to modify your images, experiment with the settings until you achieve 
satisfactory results.

Use the Image Settings menu to:

 Adjust the Image Settings

 Choose the Color Matching Type



 Adjusting the Image Settings

The Image settings include Brightness and Contrast.

Brightness
The Brightness option changes the lightness or darkness of graphics. You can adjust the brightness in a 
range of -50% to +50%.

To adjust the brightness:

Drag the scroll bar to the right or left with your mouse.

Contrast
The Contrast option changes the ratio between the brightest and the darkest parts of graphics. You can 
adjust the contrast in a range of -50% to +50%.

To adjust the contrast:

Drag the scroll bar to the right or left with your mouse.

Note:    You can confirm the effect of the setting by looking at the image on the right side of the Image 
Settings Menu window.

 See Also
Choosing the Color Matching Type



 Choosing the Color Matching Type

This feature provides you with three image color matching schemes that give you more control over the 
color in your printouts. Color Matching can also be turned off.

When Automatic is selected in the Document Type menu, the printer driver analyzes the data for each 
page of your document and automatically adjusts the Color Matching settings.

Note:    You may need to experiment with different settings until you get the output you want. Also, Color 
Matching is not available when Monochrome is selected in the Document Type menu.

The following settings are available:

Off

Turns off color matching.

Vivid

Intensifies the colors and lightens the midtones and highlights of an image. Use this setting for 
presentation graphics, such as charts and graphics.

Photo-realistic

Increases the contrast in an image. Use this setting for color photographs.

Standard

Provides output that closely matches the original screen colors. Use this setting for illustrations.

 See Also
Adjusting the Image Settings

Document Type Menu



 Choosing a Halftoning Method
To display the menu that lets you choose from various halftoning methods:

Click on         You see:

 Halftoning Options



  Halftoning Options
To create an image on your printer that looks like the image on your screen or the scanned original, the 
printer driver processes the image by using halftoning. Halftoning is the same process used in the printing
of magazines and newspapers.

The halftoning method you choose depends on the type of image you are printing. An image showing the 
currently selected halftoning effect displays in the Windows menu.

To take advantage of EPSON's intelligent color correction feature, select the Automatic option from the 
Document Type menu. When Automatic is selected, the printer driver analyzes the data for each page of
your document and automatically adjusts the settings.

Note:    Results obtained when printing graphics are directly affected by the halftoning method you 
choose. You may need to experiment with different settings until you get the output you want.

The options are:

No Halftoning

Use this setting for text and no graphics. This is the fastest setting.

Error Diffusion

Use this setting for photographic images or equivalent drawings. This is the highest quality setting.

Dithering B

Use this setting for graphic images with significant detail but limited shading.

Dithering A

Use this setting for graphic images with limited detail and shading.
Note:    When media type is set to Special coated paper - 720 dpi and the printing mode is Super - 720 
dpi, the Dithering A and B halftone options are not selectable.

Caution:
Use the halftoning methods in this driver rather than the dithering options in your software.

 See Also
Document Type menu

Media Type
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 Using the Spool Manager
When you print your document, the Epson Stylus Series printer driver uses a print Spool Manager to send
the data to your computer's hard disk and then to the printer. Then it uses a Despooler to print the data.

When the EPSON Stylus Series printing system releases your application software from printing, a journal
file is created in the default spool directory.    When a journal file is created, the EPSON Spool Manager 
assigns it to the appropriate queue.    When the journal file comes to the front of the queue, it is submitted 
to the EPSON Despooler and replayed to the target printer.

The Spool Manager allows comprehensive control over the EPSON Despooler, print queues, print journal 
files and also allows you to enable remote network printing.

 The EPSON Spool Manager Window.

 The Queue Menu.

 The Document Menu.

 The View Menu.

 The Options Menu.

 The Help Menu.



Default Spool Directory
The default directory that journal files are sent to is normally specified by the DOS environment string SET
TEMP= in your CONFIG.SYS file.

You can change the default directory by selecting the Default Spool Directory item from the Options 
menu in the EPSON Spool Manager.



The EPSON Spool Manager Window
The Spool Manager window shows the list of EPSON Stylus printer queues and journals currently printing
or waiting for printing.

 Queues
Queues shown in normal intensity represent printers that are supported by the EPSON Stylus Series 
printing system.    Queues shown in low intensity are supported by other (conventional) Windows printer 
drivers.

You can change the options of an EPSON Stylus print queue by double-clicking on it or by clicking once 
to select it and then choosing an option from the Queue menu

 Journals
Journal files are shown in their relevant queue.    You can stop journal files printing, place journals on hold,
delete a journal or re-queue a journal for later printing by double-clicking a journal entry in the queue.

Alternatively you can click a journal entry and then choose an option from the Document menu



Queues
A queue is a list of journal files currently printing or waiting to print. Queues are always associated with a 
print device and can be local to the workstation or remote (directed across a network to another    
workstation).

An icon representing your print device is displayed against the queue. When you hold a queue, journal 
files will not be printed but will wait until the queue is released. The EPSON Spool Manager places a wait 
symbol against the icon when the queue is on hold.



The Queue Menu
The Queue menu allows you to place EPSON Stylus print queues on hold, release them to allow journal 
files to be printed and identify queues as local or remote (network printing). The following options are 
available:

 Holding or Releasing a Queue

To hold or release a queue:

1 Click the queue.

2 Select the Hold option from the Queue menu.

A check mark beside the Hold option indicates the queue is currently on hold. Additionally, when a queue 
is on hold, the spool manager places a wait symbol beside the printer icon associated with the queue, and
journal files are not submitted for printing.

 Using The Windows Print Manager
The EPSON Despooler normally prints directly to the printer.

To schedule print jobs through the conventional Windows Print Manager:

1 Click the queue.

2 Either double-click the queue or select the Setup option from the Queue menu.

3 Select the Use Print Manger for this port option and choose the OK button.

 Network Printing
The EPSON Stylus Series printing system allows you to send journal files from your workstation (Host) to 
a shared directory on a network server. These can then be printed by another workstation (Remote) set 
up to run the EPSON Spool Manager and associated EPSON Stylus printer driver(s). You can do this as 
follows:

To set up the Host:

1 Click on the queue.

2 Either double-click the queue or select the Setup option from the Queue menu.

3 Select the Spool to remote printer option.

4 Click the Browse button and select the spool directory on the remote server which should receive 
journal files from the spool manager.

To set up a Remote workstation:

1 Install the EPSON Stylus Series printing system and the required printer driver(s) using the 
Windows Control Panel.

2 Run the EPSON Spool Manager by executing EPSPLMGR.EXE from the WINDOWS\SYSTEM 
directory.



3 Either double-click the queue or select the Setup option from the Queue menu.

4 Select the Remote Despool tab and click the Printing from remote queues option.

5 Click the Browse button and select the spool directory on the remote server which will hold 
journal files from host workstations.

6 Journals will be identified by the EPSON Spool Manager and submitted for printing.

Note:    This feature is quite different from the traditional remote-printer spooling provided by most 
network operating systems. Use your network to redirect the printer LPTx: ports in the usual way to take 
advantage of that feature. You may also need to enable the Windows Print Manager as described above 
on some network operating systems when port re-direction is utilized.



The Document Menu
The Document menu allows you to control journal files in your EPSON Stylus print queue.    Journals can 
be held, re-queued for printing later, deleted or kept for subsequent re-printing.

To select options appropriate to a journal file, either double-click it or select options from the Document 
menu.



The View Menu
The View menu allows you to limit the amount of information that the EPSON Spool Manager gives you. 
In addition, you can control the display of the EPSON Despooler pop-up. When options in the View menu 
are selected, the EPSON Spool Manager places a check mark beside them.

If the Show Despool Popup is cleared (no check mark is beside it), the EPSON Despooler window will not
appear when journal files are submitted for printing. It will appear, however, if an error is reported by the 
printer.



The Options Menu
The Options menu controls the default spool directory, timer and font selections as follows:

 Default Spool Directory
Choose this option from the Options menu to override the default TEMP directory setting. Journal files 
will be sent to this directory instead. This option is equivalent to the Spool Directory setting in the Queue 
Menu Setup option except that it applies to all queues.

 Timers

Update Timer

The Update Timer tells the EPSON Spool Manager how often to refresh the information displayed in the 
EPSON Spool Manager window.

Remote Timer

The Remote Timer tells a remote EPSON Spool Manager how often to look for new journal files in a 
network directory.

See the Queue Menu for more details about network printing.

 Font
This option allows you to set the default font that the EPSON Spool Manager uses for displaying 
information in the spool manager window.



The Help Menu
The Help menu provides copyright, trademark and version information about the EPSON Spool Manager 
through the About option.

 See Also
About the Epson Stylus Series Printing System



 Using the Despooler and Status Monitor
When a journal file is processed by the EPSON Spool Manager, it is submitted to the EPSON Despooler.  
The EPSON Despooler shows the progress of the current print job and identifies printer status information
such as paper out, printer off line etc.

Note:    If you have cleared (no check mark is beside it) the Show Despool Popup option in the View 
Menu of the EPSON Spool Manager, then the EPSON Despooler pop-up will only appear if a printer 
status error occurs.

 Journal Control
You can use the EPSON Despooler to control journal files similar to the Document option(s) in the 
EPSON Spool Manager. There are three buttons that allow full journal print control:

 Stop -- Cancels printing.

 Pause -- Pauses printing until you press it again

 Rewind -- Restarts printing from the current page

 Printer Status Under Windows 3.1x

The progress of the current page is shown by the image of a document in the upper right of the despooler
window. Each page of the document is divided into one or more horizontal bands for processing. Once a 
band is complete, that data is sent to the printer and the despooler starts to process the next band. If your
document is very simple, there may be only one band per page. If your document is complex (such as a 
graphic image) or your computer has little free memory, there will be many bands.

Status messages and symbols representing error conditions are displayed on the image of your printer in 
the despooler window.

When you correct a problem with the printer the despooler senses this and continues with the print job.    If
a serious error occurs, such as printer power failure, it is suggested that you re-queue the journal and 
print it again.

 Printer Status Under Windows 95

If you are using Windows 95 and your computer system is equipped with a bi-directional parallel port, the 
lower portion of the Despooler window displays the following Status Monitor:

The Black Ink and Color Ink level indicators operate similar to a fuel level indicator in an automobile.    As 



you use up ink, the indicator drops in 25% (quarter) increments.    When the level drops to 20% full, the 
indicator turns yellow.    When the level drops to 10% or less, the indicator is red.

The printer image in the Status Monitor changes according to the printer's status.    The images convey 
the following messages:

Checking Printer - the Status Monitor is polling the printer for information.

Time Out - the Status Monitor did not get the printer's reply within a certain period of time dure to heavy 
processing activity.    When you re-queue a print job, the Status Monitor will poll again.

Inquiry Received - The printer responded with the current ink level values.

Printing - The printer is currently printing a journal file.

Low Ink - This is a warning that one or both of the ink cartridges is low on ink.

Note:    This feature is not available for printers connected through a network.

 About and Help
The About button provides version and trademark information about the EPSON Despooler.    The Help 
button brings you directly to this Help Window.

 See Also
Using the Spool Manager



    Printer Status
The EPSON Despooler pops up on standard errors, such as Paper out and Printer off line, when these 
errors are reported by your EPSON Stylus printer. Try taking the printer off line or removing paper from 
the input tray while printing to demonstrate this capability.



Bi-directional Parallel Port
A regular Centronics parallel port only allows the flow of data in one direction - from your computer to your
printer.    A bi-directional port allows data to flow both ways.    This means that your EPSON Stylus printer 
can send special information back to your computer.    Refer to your computer's user guide (or ask your 
dealer) to see if it is equipped with a bi-directional port.

Most modern computer systems come with a bi-directional (PS/2 type) parallel port that meet the IEEE 
1284 Specification.    If your system is not equipped with this type of port, you can usually purchase a bi-
directional parallel interface card from your local computer dealer for a very low cost.
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 Color Printing Basics
Printing in color is a complex process that depends on the combination of your source document 
(scanned image, software generated graph, photograph, etc.), your printer driver settings, and the type of 
media you are printing on (plain paper, coated paper, transparency film, etc.).

The Epson Stylus Series printing system has several automatic features designed to analyze the type of 
document you are printing and make the task of color printing easier for you. However, there are some 
printer driver settings that you may need to change from time to time to get the kind of color printing 
results you want. Also, there are some required settings. For example, you must tell the printing system 
whether you are using plain paper or special coated paper.

There are a few things that you should keep in mind about printing with color in order to get the results 
you expect.

 Input Settings
You can make adjustments in the Window's software you use to create your documents.

With scanned documents, you can adjust scanner settings.

With digital cameras, you can adjust camera settings.

 Driver Settings
You can make adjustments through one of your printer driver's Menus.

For highest quality printing, always turn on MicroWeave and turn off High Speed in the Printing Mode
Menu.

 Media Type
You can improve quality by using the right paper or transparency film. To order high quality coated 
papers and film, see Ordering Supplies.



 Choosing Required Settings
Choose the following driver settings to match your document requirements:

Paper size The size of the paper loaded in the printer.

Orientation The direction of printing on the document.

Ink Monochrome (black) or color (CMYK) ink.

Printing Mode Super - 720 dpi, Best - 360 dpi, or Draft - 180 dpi

Media type The type of paper loaded in the printer.

 See Also
Choosing the Printing Mode



 CMYK
Cyan - Magenta - Yellow - BlacK.

The three primary process (subtractive) colors plus black.



Choosing the Printing Mode
Use the following guide tables to help you choose the most appropriate printing mode for your 
documents.

Note:    When printing speed is important, remember that the following settings take increasingly more 
time for your document to print:

Monochrome text printing

MicroWeave set to on with Monochrome

Color (CMYK)

Diffused halftone methods for complex printing

Higher resolution

 Text and Simple Graphics
Desired Results Minimum Media Setting Suggested Settings
Sharp black text Plain paper Best - 360 dpi

Monochrome
Text

Sharp black or Plain paper Best - 360 dpi
color text and basic Color (CMYK)
non-gradated graphics Presentation

Low-detail pencil Plain paper Best - 360 dpi
drawings Monochrome

Drawing

 Grayscale Graphics
Desired Results Minimum Media Setting Suggested Settings
Clear, low-detail Plain paper Best - 360 dpi
images Monochrome

Presentation

High-quality, Plain paper Best - 360 dpi
detailed diagrams Monochrome
or drawings Drawing



High-quality, Special coated paper Best - 360 dpi
photographic images                 360 dpi Monochrome
or similar drawings Photograph

 Complex Color Images
Sharp, color Special coated paper Best - 360 dpi
graphics or                 360 dpi Color (CMYK)
scanned images Photograph

Highest-quality, Special coated paper Super - 720 dpi
color graphics or                 720 dpi Color (CMYK)
scanned photographic Photograph
images

Highest-quality, Transparency film Best - 360 dpi
color graphics or Color (CMYK)
scanned images for Photograph
overhead presentations

 See Also
Choosing Required Settings

Driver Menus

Troubleshooting

Ordering Supplies



 Customizing Printer Settings
You can use your EPSON Stylus printer's control panel to perform special printing functions, select 
customized settings, and change the Default Setting Mode.    The control panel lights also provide a visual
indication of the printer's status.

Note:    Since all printer settings can be controlled from your Windows application software, you do not 
often need to use the control panel.    In fact, your application usually overrides any control panel 
selections that you may make.    Normally, you need it to do only the following:

 Turn on economy or condensed mode

 Clean the black or color print heads

 Replace the ink cartridges

 Pause the printer temporarily

 Reset the printer.

Note:    Direct customization with the control panel can be useful when you are using older DOS 
applications that do not support your EPSON Stylus printer's features.

 Control Panel Lights
The control panel lights indicate the following printer status:

Power On when the printer is on.    On some printers, it flashes when the printer is turned on or off.

Data Flashes when data is being received by the printer.    On when data remains in the printer's 
memory or when printing a self test or demonstration page.

Ink Out Flashes when the specified ink cartridge is low on ink.    On when the cartridge is empty or 
not installed.    The printer will not work if this light is on.

Paper Out On when the printer runs out of paper.    Flashes rapidly if there is a paper jam.

Economy On when economy printing mode is selected.    In economy mode the printer uses less ink 
by printing fewer dots per character.    Use this mode for rough drafts of text only.

Condensed On when condensed mode is selected.    In this mode, the printer prints selected fonts at 
60% of their width so that more characters can fit on a page.

Pause On when printing is paused and flashes when you clean the print heads or replace ink 
cartridges.    The Pause light also flashes when an error occurs.    Never turn off the printer 
when the Pause light is flashing.

Note:    Your particular EPSON Stylus printer may have additional lights.    Refer to your Reference Guide 
for details.

 Control Panel Buttons
The control panel buttons can be used singly or in combinations to perform the following functions:

Alt Used in combination with other buttons to reset the printer, clean the print heads, or 



replace the ink cartridges.    See the combinations listed below.

Pause Stops printing temporarily.    Press it again to resume printing.

Economy Selects Economy or Condensed mode as indicated by the lights.
Condensed Use this button only if you print from a DOS application.

Load/Eject Loads or ejects a sheet of paper.    The printer normally loads and ejects paper 
automatically.

Alt + Pause Clears the printer's buffer and resets the printer settings to their factory defaults.

Alt + Economy Starts the black print head cleaning cycle.    Cleaning the print head uses ink, so only 
perform a cleaning cycle if print quality declines.

Alt + Load/Eject Starts the color print head cleaning cycle.    Cleaning the print head uses ink, so only 
perform a cleaning cycle if print quality declines.

Note:    The following button combinations require you to turn the printer off first.

Alt + Power Prints a demonstration page of the printer's fonts and colors. To exit this mode, press the 
Pause button and turn off the printer.

Load + Power Checks the paper length and performs a self test.

Economy + Power Enters the printer's Default Setting Mode and prints out instructions (see below).    
To exit this mode, press the Pause button and turn off the printer.

Note:    Your particular EPSON Stylus printer may have different buttons.    Refer to your Reference Guide
for details.

 Using the Default Setting Mode
Additional printer functions are available through the Default Setting Mode.    Because the printer's factory 
defaults are designed to meet the needs of almost all users, you rarely need to change the printer 
functions listed below.

To turn on Default Setting Mode, print instructions, and make changes:

1. Turn off the printer.

2. Hold down the Economy button while you turn the printer back on.

3. Follow the printed instructions to change the default settings by pressing the buttons on the 
control panel.

4. When you are finished, press the Pause button and turn off the printer.

 Default Setting Options
You can select the following options:

Print direction.    Specifies how the print head moves across the page.    The options are Uni-D, Bi-D, 
and Auto (default).    When Uni-D is on, the print head prints in only one direction to provide the most 
precise alignment for graphics and text.    In Bi-D printing, the head prints in both directions, making 



printing faster.    When Auto is selected, the printer switches automatically between Uni-D and Bi-D as 
necessary, depending on the type of journal file.

Interface Mode.    Determines from which interface the printer receives data.    The default setting, 
Auto, allows the printer to automatically switch as needed between the parallel and serial interfaces.    
However, if you experience communication problems, you might want to set the mode to either 
parallel or serial.

Auto Interface Wait Time.    Sets the time period for the printer to wait for data from the current 
interface.    You can select a 10-second (default) or 30-second timeout.

Character Table.    Selects the set of characters and symbols that can be printed.    The default is the 
DOS Italic USA character table.    If you commonly use a language containing accents or other special
symbols from a DOS application, you can change the character set.

Loading Position.    Determines the top margin by defining how close to the paper edge the first line 
can print.    The loading position can be 3 mm (default) or 8.5 mm.    Normally you should use your 
software to adjust your top margin.

Network Interface Mode.    If you want to use the printer in a network and share it among multiple 
computers, set this feature to on.    When this feature is set to on, data may be present in the printer's 
buffer even though the printer is not printing.

Auto Line Feed.    When the auto line feed is on, each carriage return (CR) code is accompanied by a 
line feed (LF) code.    If your printed text is unexpectedly double-spaced, set this feature to off.    If text 
lines print on top of each other, set it to on.



Buffer
A memory area in your printer that stores incoming data until it is ready to be printed.



ESC/P2
The second revision of the EPSON industry standard printer control language.    The main function of the 
Stylus Series printer driver is to translate Windows printer functions to the ESC/P2 control language - the 
language that the printer understands.
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 Replacing an Ink Cartridge
Try This First
When printed images appear faint, have many gaps, or nothing prints, either wait until the document 
finishes printing or press the Pause button and then the Load/Eject button on the printer's control panel 
to eject the page. Clean one or both of the print heads. If up to three cleanings do not improve print 
quality, replace one or both ink cartridges.

If the colors you print are very different from what you expect, print a self test as described in your setting 
up guide. If one or more of the colors do not appear in the self test, replace one or both ink cartridges.

Use the following genuine EPSON ink cartridges (see Ordering Supplies). Other products may cause 
damage to your printer not covered by EPSON's warranties.

Black ink cartridge  S020034
Color ink cartridge  S020066

 Replacing the Ink Cartridge

To replace an ink cartridge:

1. Make sure the printer is on.

2. Open the printer cover.

3. Press the Pause button to turn the Pause indicator off.

4. Hold down the Alt button for about five seconds until the print head moves left slightly to the 
cartridge install position. The Pause light flashes when the carriage is in this position.

5. Lift up the clamp that holds the cartridge you want to replace as far as it will go. When you do, the
cartridge will rise partly out of the carriage.



6. Lift the cartridge out of the printer and dispose of it properly. Do not take the used cartridge apart 
or try to refill it.

Caution:
If ink gets on your hands, wash them thoroughly with soap and water. If ink gets into your eyes, 
flush them immediately with water.

Caution:
Leave the old cartridge installed in the printer until you are ready to replace it with a new one. 
Attempting to print without a cartridge installed can damage the printer.

Caution:
Use genuine EPSON ink cartridges and do not refill. Other products may cause damage to your 
printer not covered by EPSON's warranties.

Note:    When replacing the ink cartridge, make sure no paper is in the paper path. Paper loaded in the 
printer is ejected automatically when you replace the cartridge.

Note:    The carriage automatically returns to the home position (far right) after 60 seconds if you do not 
remove an ink cartridge during that time.

7. Open the package containing the ink cartridge and remove the cartridge from its protective bag. 
Next, remove the tape seal from the cartridge. Your packaging may differ slightly from that shown 
in the illustration below.



Caution:
You must remove the tape seal from the cartridge. Leaving the tape on when you install the 
cartridge will permanently damage it.

8. Lower the ink cartridge into the cartridge holder with the label on the cartridge face up and the 
arrow on the cartridge pointing to the rear of the printer. The larger (color) cartridge goes on the 
left, the black ink cartridge on the right.

9. Press the ink cartridge clamp down toward the back of the printer until it locks in place.

10. Press the Alt button again. The printer charges ink in the system and moves the print head to its 
home (far right) position. This operation takes about one minute to complete.



Caution:
The Pause indicator continues to flash while the printer performs the ink charging operation. 
Never turn off the printer while the Pause indicator is flashing. Doing so can result in incomplete 
charging of printer ink.

11. Close the printer cover.

 See Also
Cleaning the Print Heads
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 Cleaning the Print Heads
If print quality diminishes, use the printer's built-in print head cleaning cycle to ensure that the nozzles are
delivering ink properly. You can clean the color and black print heads separately.

To avoid wasting ink, clean the print head only if the print quality declines.

To clean the print heads:

1. Make sure the printer is turned on and the Pause light is on. If the Pause light is not on, press the
Pause button to pause the printer. 

Note:    When cleaning a print head, make sure no paper is in the paper path. Paper loaded in the printer 
is ejected automatically when you clean the print head.

2. Hold down the Alt button and press Economy/Condensed to clean the black print head.

 Hold down the Alt button and press Load/Eject to clean the color print head.

Note:      The cleaning cycle takes about one minute. The Pause light flashes throughout the cycle and 
then stays on when the cleaning cycle is finished. Also, you cannot perform both color and black print 
head cleaning operations at the same time.

3. Press the Pause button to resume printing.

Note:    If the print quality does not improve after you perform cleaning three times, replace the ink 
cartridge.

 See Also
Replacing an Ink Cartridge
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 Cleaning the Printer
To keep your printer operating at its best, you should clean it thoroughly several times a year. 

To clean your EPSON Stylus printer:

1. Make sure the printer is turned off. Then unplug the power cord.

2. Remove any paper from the paper tray.

3. Use a soft brush to carefully brush away all dust and dirt.

4. If the outer case or the inside of the paper tray is dirty, clean it with a soft, clean cloth dampened 
with mild detergent. Keep the printer cover closed to prevent water from getting inside.

5. If the inside of the printer accidentally gets soiled with ink, wipe it off with a damp cloth.

Warning:
Be careful not to touch the gears inside the printer.

Caution:
Never use alcohols or thinners to clean the printer; these chemicals can damage the components
as well as the case.

Caution:
Be careful not to get water on the printer mechanism or electronic components.

Caution:
Do not use a hard or abrasive brush.

Caution:
Do not spray the inside of the printer with lubricants; unsuitable oils can damage the mechanism. 
Contact your dealer or a qualified service person if lubrication is needed.

 See Also
Troubleshooting



 Transporting the Printer
If you need to transport your printer some distance, carefully repack it using the original box and packing 
materials as follows:

To transport your EPSON Stylus printer:

1. Open the printer cover and make sure that the print head is capped in the far right position. If the 
print head is not capped, turn on the printer to cap it. Then turn off the printer.

Caution:
Leave the ink cartridges installed when you transport the printer. Removing the cartridges during 
transport can damage the printer.

2. Unplug the power cord from the electrical outlet; then disconnect the interface cable from the 
printer.

3. Remove the paper tray cover from the paper tray and remove any paper in the paper tray.

4. Remove the paper tray from the printer.

5. Attach the protective materials to the printer.

6. Repack the printer and power cord in the original box.

7. Keep the printer flat in the box during transport.

8. If the print quality is poor after transporting the printer, clean the print heads.

 See Also
Cleaning the Print Heads
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 Ordering Supplies
You can purchase supplies, parts, documentation, and accessories by calling EPSON Accessories at 
(800) 873-7766 (U.S. sales only).

In Canada, call (800) GO-EPSON for sales locations.
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Getting the Best Print Quality
If print quality is not what you expect, first try the items below a step at a time until print quality improves. 
If you need further information, see Print Quality Problems.

 If images or text are not clear:

1. Try using a higher-quality paper.

2. Make sure the printer driver settings are correct.

3. Make sure the printer driver Media Type setting matches the paper loaded in the printer.

4. For color or complex grayscale graphics, turn on MicroWeave and turn off High Speed in the 
Printing Modes Menu.

5. For scanned or digital camera images, check the scanner settings.

 If the black print is faint or dots are missing:

1. Make sure you selected Monochrome in the Document Type Menu.

2. Perform a black print head cleaning, then print a self test by holding down the Load/Eject button 
and then pressing the Operate button.

3. If the self test does not print out clearly, replace the black ink cartridge.

 If colors are faint or do not appear at all:

1. Make sure you selected Color in the Document Type Menu.

2. Make sure you did NOT select No halftoning in the Halftoning Menu.

3. Perform a color print head cleaning, then print a self test by holding down the Load/Eject button 
and then pressing the Operate button.

3. If the self test does not print out clearly or colors are missing, replace the color ink cartridge.

 See Also
Print Quality Problems



Print Quality Problems
The topics in this Help window describe problems you might be having with print quality.

Color dots are missing in printed characters or graphics. The printed color image is light 
or faint.

The print head nozzles may need cleaning. See Cleaning the Print Heads.

Black dots are missing in printed characters or graphics. The printed black image is light 
or faint.

The print head nozzles may need cleaning. See Cleaning the Print Heads.

Dots are missing in printed characters or graphics.
Set the Network interface mode to on in the default-settings mode.

 See Also
Getting the Best Print Quality
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Problems with Printing
The topics in this Help window describe problems you might be having with the printer.

The Data and Pause lights flash and nothing prints.
Turn off the printer. After a few seconds turn it back on again and try printing again. If the error is not 
corrected, contact your dealer or an authorized service person.

Printing stops and the Data and Pause lights flash.
A carriage error occurred. Turn off the printer. After a few seconds turn it back on again and try printing
again. If the error is not corrected, contact your dealer or an authorized service person.

Printing has stopped and the Pause light is on.
Printing has been temporarily suspended. Press the Pause button to continue.

 See Also
Getting the Best Print Quality
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Paper Handling Problems
The topics in this Help window describe problems you might be having with paper handling.

The printer does not print; the Paper Out light is on.
No paper is loaded in the printer. Load paper in the sheet feeder; then press the Pause button to turn 
off the Pause light.

The printer loads more than one sheet at a time.
The paper may be too thin.    Use a thicker type of plain paper.

Ejected paper is wrinkled.
The paper may be too thin or damp. Do not store your paper in a damp or humid environment. Store 
paper in its original packaging.

 See Also
Getting the Best Print Quality
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About
There are several menus and windows in the Stylus printing system that give you information about the 
EPSON printer driver. These areas are labeled with "About".



About Menu
The About Menu displays copyright, trademark, and printer driver version information.



Additive colors
Colors that are produced by adding together the varying intensities of three colors: red, green, and blue.



Best - 360 dpi
A Stylus Series printing mode that creates output at medium speed and 360 dpi resolution. This mode is 
best for plain paper, special coated paper - 360 dpi, and transparency film.

You can use this mode for both monochrome and color printing. 



Bidirectional printing
Images are printed in both directions for faster printing. The High Speed printing mode uses this type of 
printing.



Brightness
The lightness or darkness level of an image. You can adjust the brightness of a printed image from the 
Image Settings Menu in your printer driver.



Cancel button
You press the Cancel button to exit from the printer driver without saving any changes to driver settings.



Collate copies
You can elect to print from the first page to the last or in reverse page order. You can also elect to collate 
(sort) a multi-page document into sets. These options are available in the Paper Menu.



Color matching options
There are four types of color matching options -- none, vivid, photo-realistic, and standard. You select a 
color matching option from the Image Settings Menu.



Contrast
The amount of difference between the darkest and lightest colors in an image. The greater the difference, 
the higher the contrast value. You can adjust the printed image contrast from the Image Settings Menu.



Copies
The number of times you want to output a document. The default value is 1.

You can enter a different value from the Paper Menu, but you should normally select multiple copies from 
the Print function of your application.



Default Settings
A value that takes effect when the equipment is turned on, reset, or initialized.



Defaults Button
You press the Defaults button from the printer driver to reset all of the factory settings.



Despooler
The Despooler prints your document from the Journal files saved on your hard disk by the Spool 
Manager. The Despooler appears on your screen automatically when you print a document.



Dithering A
A halftone printing method for graphic images with limited detail and shading.



Dithering B
A halftone printing method for graphic images with significant detail but limited shading.



Document Type Menu
A main menu in the Stylus printer driver that allows you to choose settings according to the type of 
document you are printing.    In general, you should leave the setting as Automatic.



Document Type Options
There are five options that you can select from the Document Type Menu -- Automatic, Presentation, 
Photograph, Drawing, and Text.    In general, you should leave the setting as Automatic.



Document Menu (Spooler)
A menu in the Spool Manager that allows you to hold files from printing, re-order them for later printing, 
delete them from the queue, or save them for reprinting.



Draft - 180 dpi
A Stylus Series printing mode that creates output at the fastest speed and 180 dpi resolution. This mode 
is best for printing text on plain paper.

You can use this mode for both monochrome and color text printing.



EPSON Stylus Printing System
A term used to describe the Stylus Series printer, printer driver, Spool Manager, and Despooler.



Error Diffusion
A halftone printing method for photographic images or equivalent drawings. This is the highest quality 
setting.



Font Menu (Spooler)
You can use this menu to change the Spool Manager Window font.    You access this menu from the drop-
down Options Menu in the Spool Manager.



Halftoning
Methods of using tiny dot patterns to represent images.    Halftoning provides the best picture quality, but 
slows down printing.



Halftoning Menu
A main menu in the Stylus printer driver that allows you to choose from four halftoning methods -- No 
Halftoning, Error Diffusion, Dithering A, and Dithering B.



Help Button
You press the Help button to display the Stylus printing system Help Window.



High Quality Paper
Special coated paper for ink jet printers that give you the best picture quality.    EPSON provides two type 
of special coated papers -- 360 dpi and 720 dpi.    See Ordering Supplies for information.



High Speed Option
An option that you can select from the Printing Modes / Options Menu that turns on birectional printing for 
faster print speed.    This mode is good for drafts and low-detail drawings and graphs.



Holding (Queue)
If a journal is still in the Spool Manager Queue Menu, you can place it on hold for printing later or deleting.



Image Settings Menu
A main menu in the Stylus printer driver that allows you to adjust the image brightness and contrast and to
choose the color matching type -- Off, Vivid, Photo-realistic, and Standard.



Ink Cartridge
The plastic, replaceable ink container.    The Stylus Series uses one color (CMY) cartridge and one black 
cartridge.



Ink Jet
A method of printing in which each letter or symbol is formed by precisely spraying ink onto paper.



Ink Options
The two ink options are color (CMYK) or Monochrome (black).    You can choose this option from the 
Document Type Menu.



Landscape
The type of printing when the paper is oriented lengthwise.    The opposite is Portrait.



Media
Materials upon which data is printed such as enevlopes, plain paper, special coated paper, and 
transparancy film.



Media Type Options
Part of the Printing Mode / Options Menu that allows you to choose the media type -- Plain paper, Special 
coated paper - 360 dpi, Special coated paper - 720 dpi, and Transparency film.



Network Printing
Your Stylus Series printer is designed to be used as a network printer.    You turn the network interface 
mode on or off from the printer's control panel.

You can also control network print queues from the Spool Manager Queue Menu.



No Halftoning Option
This is a Halftoning Menu option that allows you to turn halftoning off.    This option is used for printing 
drafts, simple graphics, or text.



Ok Button
You press the Ok button from the printer driver menu to save all setting changes and exit the driver.



Options Menu (Spooler)
The Spool Manager pull-down Options Menu allows you to change the Default Spool Directory, adjust 
timers, and change the default font for the Spool Manager Window.



Orientation
There are two ways you can print on your media: Portrait and Landscape.    Portrait images look like this 
screen.    Landscape images are printed lengthwise.    The Landscape option is ideal for printing wide 
spreadsheets.



Paper Size
This is a required option when you plan to print on different size media.    You can access the Paper size 
options from the Paper Menu.    The default paper size is Letter (8.5 X 11.0 inches).



Paper Source Option
The Stylus Series printers have an Auto Sheet Feeder.    This is the default setting in the Paper Menu and 
you do not need to change it.



Paper Menu
A main menu in the Stylus printer driver that allows you to choose Paper Size, Paper Source, paper 
orientation, and the number of collated copies.



Portrait
Portrait images look like this screen.    Images are printed left to right from the top of the paper to the 
bottom.    The opposite is Landscape.



Printing Mode / Options Menu
A main menu in the Stylus printer driver that allows you to choose Printing Mode (Super, Best, Draft), 
Media Type, and print speed (MicroWeave, High Speed).



Queue Menu (Spooler)
A menu in the Spool Manager that allows you to place journals on hold, release them to be printed, and 
identify if a queue is local or remote.



Releasing a Queue
You can use the Spool Manager Queue Menu to release journals you have placed on hold.    The journals 
will then be printed.



Reverse Page Order
This is an option you can select from the Paper Menu.    If you check this option, your document prints 
from the last page first.    This is useful for multi-page documents that you want to keep in normal reading 
order.



Special Coated Paper - 360 dpi
A specially coated paper that allows the highest quality printing at 360 dpi.    Use this paper in Best - 360 
dpi mode when you are printing high-detailed images.    See Ordering Supplies.



Spool Manager
When you print your document, the printer driver uses a print spool manager to send the data to your 
hard disk and then to the printer.    This releases your computer and allows printing to take place in the 
background.    The Stylus printing system then uses the Despooler to print your document.

The Spool Manager icon appears when you send data to the printer.    Double-click the icon to activate the
Spool Manager Window.



Status Monitor
A dialog box that you see when you display the Despooler.    It provides information on current printer 
status and ink cartridge supply levels.



Super - 720 dpi
A Stylus Series printing mode that creates output at a slower speed and 720 dpi resolution. This mode is 
best for high quality output on special coated paper - 360 dpi or 720 dpi.

You can use this mode for both monochrome and color printing.

Note:    Do not use this mode on transparency film.



Timers Option (Spooler)
There are two types of timer associated with the Spool Manager -- the Update timer and the Remote 
timer.

The Update timer tells the EPSON Spool Manager how often to refresh the information displayed in the 
Queue Menu.

The Remote timer tells a remote EPSON Spool Manager how often to look for new journal files in a 
network directory.



Transparency Film
A Stylus Series printer can print on specially prepared transparency film for use on overhead projectors.    
You must use only film that is designed for use with ink jet printers. See Ordering Supplies.

Use the Best - 360 dpi mode when you print on    transparency film.



View Menu (Spooler)
The Spool Manager has a pull-down View Menu that allows you to limit the amount of information that the
Spool Manager displays.    You can also choose to keep the Despooler from appearing when you print.




